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Warranty

All products manufactured by ICP DAS are warranted against defective materials for a
period of one year from the date of delivery to the original purchaser.

Warning

ICP DAS assumes no liability for damages consequent to the use of this product.

ICP DAS reserves the right to change this manual at any time without notice. The
information furnished by ICP DAS is believed to be accurate and reliable. However, no
responsibility is assumed by ICP DAS for its use, not for any infringements of patents or
other rights of third parties resulting from its use.

Copyright
Copyright © 2021 by ICP DAS. All rights are reserved.

Contact Us
If you have any questions, please feel free to contact us via email at:
Service@icpdas.com
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1. Introduction

The M-6088-32 provides 32-channel PWM (Pulse Width Modulation) Output, and can
be used to develop powerful and cost-effective analog control systems. PWM is a
powerful technique for controlling analog circuits that uses the Digital Output to
generate a waveform with a variable duty cycle and frequency which can then be used
to control an analog circuit in applications such as controlling the position or speed of
motors, the brightness of lamps, or the speed of fans, etc. Either burst mode or
continuous mode can be used for the PWM output depending on the application. It
supports both the Modbus RTU and the DCON protocols, and External PWR allows the
load voltage to be increased from +5 to +40 V for the 32-channels PWM (Pulse Width
Modulation) output.

When required, communication with the M-6088-32 can be programmed based on the
Modbus RTU protocol, with the added benefit that different addresses can be
configured via hardware to allow for Modbus RTU communication.

Features

32-channel PWM Output

Burst Mode and Continuous Mode for PWM Output
Individual and Synchronous PWM Output

4 kV ESD and EFT Protection

Supports the DCON and the Modbus RTU Protocols
Embedded Dual Watchdog

Wide Operating Temperature Range: -25 to +75°C

¥y ¥ ¥ ¥ ¥%v ¥

DIN-Rail Mounting or Wall Mounting
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Application
P Heating system in buildings

B Ventilation system

» Controlling Fan Speed

5 to 40V PWM output

Al @

M-6088-32

PWM (Continuous Mode)
MCU

Software Trigger
PWM (Burst Mode)
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2. Hardware

2.1 Specifications

‘ Model M-6088-32
PWM Output
Channels 32
Type Open Collector
Sink/Source (NPN/PNP) Sink
Load Voltage +5 ~ +40VDC
Max.Load Current +40VDC @ 200 mA/Channel
PWM Frequency 50 Hz
PWM Duty Cycle 0.1t0 99.9%
Mode Burst, Continuous
Burst Count 1 to 65535
Min. PWM Period 1ms
Power-on Value Yes
Safe Value Yes

Communication

Interface RS-485 X 1

Data Format N,8,1/0,8,1/E,8,1/N,8,2

Baud Rate 1200 ~ 115200 bps

Protocol Modbus RTU or DCON

Dual Watchdog Yes, Module (1.6 seconds), Communication (Programmable)

LED Indicators

System 1 as Power/Communication Indicator (Red LED)

Isolation

Intra-module Isolation,
Field-to-Logic

2500 VDC

EMS Protection

ESD (IEC 61000-4-2) +4 kV Contact for each Terminals
+8 kV Air for Random Point

EFT (IEC 61000-4-4) +4 kV for Power

Surge (IEC 61000-4-5) +2 kV for Power

Power Requirements
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Reverse Polarity Protection Yes

Input Voltage Range +10 ~ +48 VDC
Consumption 1.0 W Max.
Mechanical

Dimensions (L x W x H) 116 mm x 120 mm x 64 mm
Installation Wall Mounting or DIN-Rail Mounting

Environment

Operating Temperature -25 ~ +75°C
Storage Temperature -30 ~ +75°C
Humidity 10 ~ 90% RH, Non-condensing

M-6088-32 User Manual
-7-



2.2 Appearance

PWM Output Group 1 PWM Output Group 1

N/

Ext.PWR1
PWM GND1

PWM19
PWM18
PWM17
PWM16
PWM15
PWM14
PWM13
PWM12

PWM11

a8 M-6088-32

Terminal Resistor
INIT

B

Ext.PWR2
PWM GND2

PWM20
PWM21
PWM22
PWM23
PWM24
PWM25
PWM26
PWM27
PWM28

PWM Output Group 2 POWER

LED Indicators

= PWR: Power/Communication Indicator

PWM Outputs
32-Channels Open Collector

Switch (SW1)
INIT
Terminal Resister
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2.3 Pin Assignments

OlWMd
TlMd
ZlMd
ElWmd
rlmd
SMd
SWMd
LIWMd
BWMd
eWMd
0TWMd

TTWMmd
CTWMd
ETWMd
PTWMd
STWMd
9TWMd
LTIWMd
8TWMd
6TIWMd
TAND WMd
TdMd %3

\Coas M-6088-32

PWR

A~
=z[l~

i

m
W

Ty

Terminal Resistor{° A~

INIT:

X (€ @

!

TEWMd
OEWMd
6¢INMd

gMd
LTWMd
9ZMd
SZhMd
PMd
£Z2WMd
CCMd
TZWMd
0ZMd
CAND WMd
cdMd™xd
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2.4 Wire Connections

Groupl
PWMO ~ PWM19
(Sink )

+5 to +40 VDC

[ PWMx
T|2| Load S
+— 106 || ExXt.PWR1

- T 108! || PWM.GND1

Group2
PWM20 ~ PWM31
(Sink)

+5 to +40 VDC

[ PWMx
1|2/ Load S
T D@ Ext.PWR2

- T 0S| || PWM.GND2
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2.5 Internal 1/O Structure

DATA+
DATA-

+Vs
GND

DC/DC

/ INIT +5 V@

S€

I

EEPROM

|| Embedded
Controller

JT1

RS-485

G

Interface

—®+5V

Power
Regulator

R

PWM
Control

—Ext.PWR1

PWMO

PWM19

- PWM.GND1

— Ext.PWR2

PWM20

PWM31

®+S5V Ext.PWR1
v +S5V @j:
—>| ¥itd .
Ext.PWR1
— . EXEP
* 4S5V @»
— | wap =
v
Ext.PWR2
+S5V @i
N N
R
- 3 Ext.PWR2
. * @
* 455V @3"
.
N
—p| X5
v

- PWM.GND2
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2.6 Switch (SW1)

Swi 4 ON -
OFF -
H on_|-
=W | |
@) :lN 5 ON Enable Terminal Resister
OFF Disable Terminal Resister (Factory default)
:l1—| . LON_ |INIT Mode
OFF Normal Mode

O3 M-6088-32

-
=l
Terminal Resistor—{°CHl~
INIT 1 CHl—

SW1

i '|'.['m'
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2.7 Dimensions (unit: mm)

3/7.8 Z:_—-__: |l

35.5

Il

38.5

| L

A

6L1?'_=I

Left View

116.0———

120.0

112.6

i I

.%

Front View
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3. Configuration via RS-485

» The factory default settings for RS-485 communication
« Address: 1

Protocol: Modbus/RTU

Baudrate: 9600

Parity: N,8,1

Response Delay (ms): 0

Note

If there are multiple M-6088-32 connected to the same RS-485 network, each
module needs be set with a unique RS-485 address. More than one module having
the same address will cause communication failure

» Testing RS-485 Communication
1. Download the DCON Utility Pro from
ICPDAS web site : https://www.icpdas.com/en/download/DCON Utility Pro

2. Launch the DCON_Utility _Pro.exe.

18 DCON Utility Pro PC W 4.0.0.1 Beta Version Searching COM4 .
= B & =l F] =1 {$al
E@ B (@] =[] 21 [l (7] (@] e
""" COMA4:* D Address Baud Rate Checksum Format Status

Stop Search

Start Search

Set COM port Configuration
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3. Click the icon to configure the COM port.

rill

4. Select the COM Port number used to connect the M-6088-32 logger.

COM Port Search Options @

com4 |V start 0 End 255
-COM1 '

COM3 'Gum | Format‘

COM4

com2 [[]1 38400 119200

g
9600 [C1 4800 [[]1 2400 11200
"] Search RU-87PN Addr. Mode Timeout 300 ms
Search And Get I/O Configurations
Start Search Exit

5. The Baud Rate is factory default to 9600 bps.

COM Port Search Options @

com4 ¥  Start 0 End 255

Baud Rate Protocol | Checksum | Format|

115200  [[157600 138400 119200

9600 14800 12400 11200

["] Search RU-87PN Addr. Mode Timeout 300 ms
Search And Get I/O Configurations

Start Search Exit
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6. Select the Protocol tab.

COM Port Search Options @
coM4 ~ Stat 0  End 255
Baud Rate| Protocol Checksum | Format|

DCON Modbus RTU [l Modbus ASCII
["] Search RU-87PN Addr. Mode Timeout 300 ms

Search And Get I/O Configurations

Start Search Exit

7. Select the Format tab and check the parity that set in the logger.

COM Port Search Options @

CoM4 ~ Stat O End 255

'Baud Rate | Protocol | Checksum Format ‘

N8,1 l [IN,8,2 [ES8,1 o,81

["] Search RU-87PN Addr. Mode Timeout 300 ms
Search And Get I/O Configurations

Start Search | Exit

8. Click the Start Search icon. b

9. The M-6088-32 logger searched out will be listed as below.

& Dcon utility Pro PC v 4.0.0.1 Beta Version Searching COM4

EEEIII@III

- COM4:* 1D Address Baud Rate Checksum Format Status Description

608832  1[0th] 9600 Disabled  N,8,1  Remote /O [Madbus RTUJ32*PWM

Comments
Supported
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10. Click the module name to configure the logger.

T 08 e — ==

Configuration |PWM (CH:0 ~15) I PWM (CH:16 ~32) | Power On/Safe Status | WDT | Commands Log | Summary | About |

Protocol Modbus RTU -

Address 1 = 01H

Baud Rate 9600 -

Parity N,8,1 -

Checksum Disabled -

Response Delay 0 ms

Set Module Configurations
I Start Synchronized PWM l I Stop Synchronized PWM l PWM Output High/Low Level 1: Level nverse, Sequence no inverse -
| I Exit l l Save Al PWM Configurations l
Note

The Protocol/Baud Rate/Parity/Checksum items marked with "(INIT*)” means that
when any of those items needs be modified, the pin 1.INIT needs to be set in ON
position and power cycle the logger, then the item can be modified. After complete
setting, set the pin 1.INIT back to OFF position and power cycle the logger again to

take the setting effect.
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» PWM tab

Period (0~655.35 sec)  puty

Sync. Start PWM ON/OFF

Burst Count
Pulse Mode

Remained Burst Count

Sync. Stop PWM Status

18 W8832 Firmware[A102
e
ConfigNgtion | PWM (CH:0 ~1f) | pwm @i:16 ~32f| Power On/SafE Stat
Perio 655.35 sec) P Duty ‘Arst Cuur‘ Pulse M c. Start  Sync. Stop Start PWM Bt ean = JBUSRCE

CH:00 qp0.50 50.0 0 Continuous Apply PWM - 0

CH:01 q00.50 500 0 Continuous £ ] Apply PWM || OFF 0

CH:02 000,50 500 0 Contiwous [ [ Applypum | [OFE 0

CH:03 000.50 500 0 Continuous 7] [ Apply PWM || B 0

CH:04 (00.50 500 0 Continuous 0 O Apply PWM || OFF | 0

CH:05 000.50 500 0 Conthuous [ [ appy Pun |1 [BEE 0

CH:06 000.50 500 0 Continuous [ L Apply PWM ] = 0

CH:07 000.50 500 0 Continuous £ ] Apply PWM || OFF 0

CH:08 (00.50 50.0 0 | F Apply PWM || B 0

CH:09 (00.50 500 0 Continuous 0 O Apply PWM || OFF | 0

CH:10 00050 500 0 Conthuous [ [] AppypwM | [OFE 0

CH:11 000,50 E Conthuous [ [ ropy pwmt [ [BEE 0

CH:12 qpp.50 500 0 Continuous £ ] Apply PWM || OFF 0

CH:13 900,10 0.0 0 Contiweus [ [ Aoy pwm | [BFE 0

CH:14 000.50 500 0 Continuous [ (| Apply Pwi1_|'] B 0

CH:15 (00.50 50.0 0 Continuous 0O 0 Apply PWM il - 0

[[ Set all channels as CHO ] ]

-
I Start Synchronized PWM l I Stop Synchronized PWM ] PWM Output High/Low Level 1: Level inverse, Sequence no inverse v
| I Exit ] I Save Al PWM Configurations ]
\

» Host Watchdog

Host Watchdog is used to monitor the RS-485 communication status; if the host

(PC) does not send command “~**” in the time period of WDT Timeout setting, the

enabled Host Watchdog will announce the timeout error and turn the relay output

to Safe value to avoid an unsafe act. Users can not control the relay until the

command “~AA1” is sent to clear the WDT timeout status.

On this tab:

1. Set the time period for WDT timeout, check the checkbox next to Enable WDT
and click the Set WDT button to enable the Host watchdog.

2. Check the checkbox next to Send Host OK to send the “~**” command.

3. Uncheck the checkbox next to Send Host OK to stop sending ~** command, the
Host watchdog timeout will occur and relay will turn to Safe value.

4. Click the Reset WDT button to clear the Host watchdog timeout status.

5. Uncheck the checkbox next to Enable WDT and click the Set WDT button to
disable the Host watchdog.

M-6088-32 User Manual
-18 -



Note

The relay will not turn to Safe value when alarm for detected liquid is enabled. If
the alarm is enabled, the relay will be linked to the Alarm status. In case an Alarm
occurs, the relay turns ON, it can be used to turn on the user’s alarm light or
beeping alarm or other device.

BO8832 Fir

Confguraton | PWH (CH:0 ~15) | PWM (CH:16 ~32) | Pawer OnfSafe Status| WOT | Commands Log | Summary | About
Enable WOT Enable Output When WDT Timeout

WOT Timeout 1.00 Set Timer
(0.1 ~ 255 sec)

Reset Watchdog Status |

Start Synchronzed PWM Seap Synchronzed PWM PWM Output High/Low Level 12 Level nwverse, Sequence no mverse

Ext Save Al PWM Configurations

> INIT

In case of the following situations, users have to set
the pin 1.INIT on SW1 in the ON position and
power-cycle the M-6088-32 module:

- Change protocol from PC
- Change DCON configuration such as baud rate, parity and checksum
- Communication failure with a M-6088-32 module.
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18 508832 Firmware[A102] =

|| Configuration | PWM (CH:0 ~15) | PWM (CH:16 ~32) | Power On/Safe Status | WDT | Commands Log | summary | About |

Protocol (INIT*) DCON -

Address 0 = [00H]

Baud Rate (INIT*) 9600 -
Parity (INIT*) N,8,1 -
Checksum (INIT*) Disabled -

Response Delay 0 ms

Set Module Configurations

l Start Synchronized PWM ] l Stop Synchronized PWM ] PWM Output High/Low Level 1: Level inverse, Sequence no inverse -

I Exit I [ Save Al PWM Configurations ]

When a M-6088-32 module is powered-on with the pin 1.INIT in ON position, the
protocol is DCON, address is 0, Baud Rate is 9600 bps, Parity is set to N/8/1 and
Checksum is disabled.

After configuring the communication parameters, click the Set Module Configurations
button, set the INIT to OFF position and power-cycle the M-6088-32 to take the settings
effect.
Note
The INIT switch does not need to be set in the ON position when changing the
address, baudrate and parity for ModbusRTU communication; users only have to
power-cycle the module after complete configuration.
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Appendix A: DCON Command Sets

A-1. M-6088-32 DCON Command Sets

Command Description

#AAl1lcDD Channel PWM start/stop for lower 16 channels
c: channel number in hex, 0 ~ F for channel 0 to 15
DD: 00 for stop and 01 for start
response
> for OK

I for host watchdog timeout

#AAACDD Channel PWM start/stop for lower 16 channels

c: channel number in hex, 0 ~ F for channel 0 to 15
DD: 00 for stop and 01 for start

response

>

I for host watchdog timeout

#AABcDD Channel PWM start/stop for upper 16 channels

c: channel number in hex, 0 ~ F for channel 16 to 31
DD: 00 for stop and 01 for start

response

>

I for host watchdog timeout

%AANNTTCCFF [set configuration, NN: new address, TT = 00, CC: new baud rate,
FF: bit 6 for DCON checksum
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Command

Description

@AADI Read PWM status of all channels
response
IAAHHHHHHHH, HHHHHHHH in hex, each bit corresponds to
a channel, where 0 for stopped and 1 for started
@AADOHHHHHH |Start/stop PWM for all channels
HH HHHHHHHH: in hex format, each bit corresponds to a channel,
where O for stop and 1 for start
$AA2 Read configuration
$AA5 Read reset status
IAAL1 first after power on, !AAO others
$AACccB Read channel burst count remained in burst mode
cc: channel in hex, 00 ~ 1F
response
IAAHHHH, HHHH in hex
$AACccD Read channel duty cycle

cc: channel in hex, 00 ~ 1F
response

IAAdd.d

$AACccDdd.d

Set channel duty cycle
cc: channel in hex, 00 ~ 1F

dd.d: duty cycle, 00.0 ~ 99.9

M-6088-32 User Manual
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Command

Description

$AACccL

Read channel pulse period in second
cc: channel in hex, 00 ~ 1F
response

IAAddd.dd

$AACccLddd.dd

Set channel pulse period in second
cc: channel in hex, 00 ~ 1F

ddd.dd: pulse period, 000.00 ~ 655.35

$AACCcCcN

Read channel sync mode
cc: channel in hex, 00 ~ 1F
response

IAAtp, t for sync start and p for sync stop, it can be 0 for
disabled and 1 for enabled

$AACCCNtp

Set channel sync mode
cc: channel in hex, 00 ~ 1F
t: sync start, 0 to disable and 1 to enable

p: sync stop, 0 to disable and 1 to enable

$AACCCP

Read channel burst count
cc: channel in hex, 00 ~ 1F
response

IAAHHHH, HHHH in hex

$AACccPhhhh

Set channel burst count
cc: channel in hex, 00 ~ 1F

hhhh: burst count in hex

M-6088-32 User Manual
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Command

Description

$AAF read firmware version
$AAI read INIT status
response:
IAAO -> INIT short to GND
IAAL -> else
$AAM read module name
$SAAP Read Modbus RTU/DCON protocol
response:
IAAO -> DCON
IAA1 -> Modbus RTU
$AAPN Set Modbus RTU/DCON protocol
N-> 0: DCON, 1: Modbus RTU
$AAW Save PWM configuration to EEPROM
$AAYS Sync start/stop all synced channels which are specified by the
$AACccNtp command
s: 0 to stop and 1 to start
~** clear host watchdog timeout counter
~AAQ0 read host watchdog status
~AAl clear host watchdog timeout status
~AA2 read host watchdog enable/disable status and timeout value
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Command

Description

~AA3ETT

enable/disable host watchdog and set timeout value
E-> 0: disable host watchdog, 1: enable host watchdog

TT: host watchdog timeout in 0.1s in hex format

~AA4P

Read the power on PWM settings
response:

IAAhhhhhhhh, hhhhhhhh in hex, each corresponds to a
channel, 0 to stop and 1to start

~AA4S

Read the safe PWM settings when host watchdog timeout
response:

IAAhhhhhhhh, hhhhhhhh in hex, each corresponds to a
channel, O to stop and 1to start

~AAG6Phhhhhhhh

Set the power on PWM settings

Hhhhhhhh: in hex, each corresponds to a channel, 0 to stop and
1to start:

~AAG6Shhhhhhhh

Set the safe PWM settings when host watchdog timeout

Hhhhhhhh: in hex, each corresponds to a channel, 0 to stop and
1to start:

~AAD

Read inverse settings
response:

IAAhh, hh in hex, bit 1 for inverse high/low level and bit 2 for
inverse high/low sequence
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Command

Description

~AADhOh

Set inverse settings

hh: in hex, bit 1 for inverse high/low level and bit 2 for inverse
high/low sequence

~AARD

read response delay time in ms in hex format
response:

IAAhh, hh in hex

~AARDVV

set response delay time in ms, VV in hex format, 00 - 59

Baud Rate Setting (CC)

Bits 5:0

Baud rate, 0x03 ~ Ox0A

Code 0x03 0x04 0x05 0x06
Baud 1200 2400 4800 9600
Code 0x07 0x08 0x09 Ox0A
Baud 19200 38400 |57600  [115200
Bits 7:6

00: no parity, 1 stop bit
01: no parity, 2 stop bits
10: even parity, 1 stop bit
11: odd parity, 1 stop bit

Data Format Setting (FF)

Bit 6

0: checksum disabled
1: checksum enable
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Appendix B: ModbusMasterToolPC

ModbusMasterToolPC is a free, easy-to-use tool for Modbus communication and
diagnosing the wiring.

ICPDAS web site :https://www.icpdas.com/en/download/ModbusMasterToolPC

This section intends to guide the steps for creating the Modbus communication with
M-6088-32 logger.

1. Launch the ModbusMasterToolPC.exe.

2. Select New in the File menu.

Modbus Master Tool V1.1.5.0 2021/06/04\Download\ModbusMasterToolPC\Configuration File... E@B

[ File | Setup Connection Window About
3 New Ctrl+N
& Open Ctrl+O
5 My List
Save Ctrl+S
Save As  Ctrl+A

Exit Ctrl+X

3. Input the file name and click on the Save button.

m Create aNewFile =
| .« ModbusMasterToolPC » Configuration File » UserDefined ~ |44 ||| = UserDefined L
LEEE -  FEERR - @
L~ = - GuAL E- 5l Hih
t | | M-6088-32.mmt 2021/10/15 F4F .. MMTB= 1K
" | MyFileWorkmmt 2021/6/4 T4 02.. MMTHZ= 1KB
i
k
K
L
E
a
=]
- 1
| ——
BEZBN): [M-6088-32mmt | -
F1EEZ(T): | Modbus Master Tool Files (*.mmt) v]
- BRI 2 | [ zee |[_®= |
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4. Select Connect in the Connection menu.

LJ Modbus Master Tool V1.1.5.0 2021/06/041\Download\ModbusMasterToolPC\Configuration File... @@n

File Setup | Connection | Window About

Disconnect

Slave ID=1,FC=4
Error =0

Al (3x) Base O Value Description
0 (0x0) 0

1(0x1)
2 (0x2)
3 (0x3)
4 (0x4)
5 (0x5)
6 (0x6)
7 (0x7)
8 (0x8)
9 (0x9)

OO0 0O OO0 000

Disconnect

5. Select the communication interface.

i e
Interface: |COM4 Scan Interval(ms):
Baudrate: 9600 B Timeout(ms): 200
Data Bit: |8 v

4

Delay Between Poll(ms): 20

4

Parity: |0-None Parity

Stop Bit: |1 v
Mode: @ RTU | © ASCII ‘ Cancel ‘I‘ OK ‘

When using RS-485 as the interface, select the COM port, check the RTU mode and
click on the OK button.

6. Select Definition in the Setup menu.

Modbus Master Tool ¥1.1.5.0 2021/06/04L\Download\ModbusMasterToolPC\Configuration File... @@n

File | Setup | Connection Window About
Definition I |

New Window
Set Value
Set Description
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7. Select the Modbus function code, input the start address and length, and click on
the OK button.

e W

Slave ID: 1 | OK
Type:|Read Coils Status (Oxxxx) for DO v‘
Addresses: ) Base 0 @ Base 1 Cancel
Address: 1
Length: 32 00001 to 00032
Format: |Singed Int16  ~
Descriptions: [ | Clear All Descriptions

8. Read data.

Modbus Master Tool ¥1.1.5.0 2021/06/04I\DownloadyModbusMasterToolPC\Configuration File... | .= =] g
Ld

File Setup Connection Window About -8 X
Slave ID=1, FC =1
Error=0
DO (Ox) Base 1 Value Description
. 00001 = 1
00002 =
00003 =
00004 =
00005
00006
00007

00008
00022

00023 =
00024 =
00025 =
00026 =
00027 =
00028 =
00029 =
00030 =
00031 =
00032 =

»

m

m

|
- -2 OO0 0O00O00O00O0O0D OO0 OO0 OO

1

Connection is established. Serial Port= COM4
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9. Write data to Holding Register or Coil Status

1. Highlight the Modbus address in the Holding Register or Coil Status list
2. Select Set Value in the Setup menu.
3. Input the data in the Value box and click on the OK button

Setup | Connection Window About -

Definition

New Window

I Set Value I

Set Defcription

|Descripti0n

Connection is establisled. Serial Port= COM4 |

D il Value =

@ ON

n Modbus Master Tool V1.1.5.0 2021/06/04fDownload\ModbusMasterToolPC\Configuraticon File... |l=[E] X |

kd File Setup Connection Windo About - 8 X
Slave ID = 1, FC = 1 /
Error=0
DO (0x) Base 1 Value ﬁescription -l
00001 = 1 E
00002 = 0
00003 = 0
00004 = 0
00005 = 0 ~
Connection is established. Serial Port= COM4
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Appendix C: Modbus Address Table

C-1. M-6088-32 Modbus Address Mappings (Base 1)

Address Description Attribute
00001~ |PWM status RIW
00032 0: Stop
1: Start

00129 ~ | PWM safe value when host communication R/W

00160 timeout
0: Stop
1: Start

00161 ~ Power on value of the PWM status R/W
1. Start

00257 Protocol R/W
0: DCON
1: Modbus RTU

00260 Modbus Host Watchdog mode R/W
0: The same as I-7000 series modules
1. The AO and DO command will clear Host
Watchdog timeout status

00261 Host Watchdog R/W
0: Disabled
1: Enabled

00266 Inverse the PWM output level R/W

0: No inverse
1: Inverse
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Address Description Attribute
00267 Inverse the pulse output high/low R/W
seguence
0: low then high
1: high then low
00270 Host Watchdog timeout status, write 1 to clear | R/W
the Host Watchdog timeout status
10273 Reset status R
0: Not the first read after power-on
1: First read after power-on
00289 Save all PWM configurations into EEPROM, W
write 1 to save
00290 Sync start/stop W
0: sync stop
1: sync start
00961 ~ | Enable/disable channel PWM sync start |R/W
00992
00993 ~ | Enable/disable channel PWM sync stop |R/W
01024
30481 Firmware version (low word) R
30482 Firmware version (high word) R
30483 Module name (low word) R
30484 Module name (high word) R
40485 The module address, valid range: 1 ~ 247 R/W
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Address Description Attribute
40486 Bits 5:0 R/W
Baud Rate, 0x03 ~ Ox0A
Code |0x03 |0x04 |0Ox05 |0Ox06
Baud |1200 |2400 (4800 [9600
Code |0x07 |0Ox08 |0Ox09 |OxO0A
Baud |19200 38400 |57600 |115200
Bits 7:6
00: No parity, 1 stop bit
01: No parity, 2 stop bits
10: Even parity, 1 stop bit
11: Odd parity, 1 stop bit
40488 Response delay time in ms, valid range: 0 ~ | R/W
89
40489 Host Watchdog timeout value, 0 ~ 255, in 0.1s | R/W
40492 Host watchdog timeout count, write O to clear | R/W
40673 ~ | PWM pulse period in 0.01s, 0 to 65535, 0 for | R/W
40704 always low.
40705 ~ | PWM duty cycle in 0.1%, 0 to 1000, O for R/W
40736 always low, 1000 for always high
30769 ~ | PWM burst count remained in burst mode R
30800
40801 ~ | PWM burst count, O for continuous mode R/W

40832
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Revision History

Revision

Date

Description

1.0.0

2021/10

First released
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